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Well, after a bit of doing, the ibiblio rsync "problem"
has finally been ironed out. In the interim, we lost
some mirrors but gained some new ones. On some,
the directory structure changed. If you haven't
already done so, you will need to download the new
source.list file. Save the file to
your /home/[user]/Downloads
directory. Open a terminal and
gain root access. As root, first
enter cp/etc/apt/sources.list
/etc/apt/sources.list.orig.
This will create a backup of
your original sources.list file.
Then, enter cp/home/[user]/Downloads/sources.list
/etc/apt/sources.list, and
answer "Yes" when prompted
to overwrite your old
sources.list file. Alternatively,
you can follow essentially the
same instructions that are
posted in the forum by pinoc.
Once you've done either one
of the methods above, you will
need to launch Synaptic and
click on the "Reload" button to
read the new package list.
Then, just update as you
normally would.
Since we've lost some mirrors
in the process, your "favorite" mirror may no longer
be valid and active. At the same time, since we've
also gained some new repository mirrors, so feel
free to browse through the list and select one that's
closest to you.

Meanwhile, those of us in the Northern hemisphere
are preparing for the arrival of Spring. One of the
most common thoughts that is associated with the
arrival of Spring is the annual renewal that it
delivers. In that vein, KDE 4.6 has hit the repository.

Xfce 4.8 is nearing completion,
and should be hitting the
repository very soon. Work is
actively occurring to bring the
2.6.37 Linux kernel to the
repository, as well. The work of
maintaining a distro like
PCLinuxOS is never ending,
and Texstar and the rest of the
PCLinuxOS developers work
tirelessly to bring you the most
stable and up­to­date
applications and components.
I'm going to depart from my
usual rundown of the magazine
contents this month. Instead, I
want to talk a little bit about
Gnome 3. Anyone who reads
The PCLinuxOS Magazine
knows that, for over the last
year, we've been writing
extensively about the desktop
environments that PCLinuxOS
is available in as ready­to­
install LiveCDs. First, we
started with KDE 4, then Xfce,
LXDE, and finally, e17. Thanks

to Patrick Horneker, we're even covering
WindowMaker, one of the alternate desktops in the
PCLinuxOS repository that doesn't have an ISO
release. We've even produced special editions of the

magazine featuring the desktops that we've covered.
Knowing that Gnome 3 was "in the pipeline," I
purposely held off on covering the Gnome desktop
until the arrival of the new version.
It's appearing as if Gnome users are poised to
endure a situation similar to what KDE users
experienced when KDE moved from 3.5.10 to KDE
SC 4.x, when the much anticipated Gnome 3 is
released in April. Hopefully, the Gnome developers
have used the faulty delivery of KDE 4.x upon KDE
users as an example of how not to roll out a new
major release. As you may remember, KDE 4.x was
met with a lot of resistance from KDE users. KDE 4
was different in a lot of ways, and a lot of KDE
3.5.10 users didn't feel at home with those changes.
Plus, KDE 4 ratcheted up the hardware
requirements considerably, so many users who ran
KDE 3.5.10 on older equipment could no longer run
KDE 4 on that same equipment. In fact, there is a
fairly loud minority of KDE users who still will not
move to KDE 4.x, opting instead to hold onto still­
working copies of KDE 3.5.x for as long as they can.
Just as what happened with KDE, the Gnome camp
will experience many users who embrace the
changes that are forthcoming in Gnome 3. Many of
those changes are quite radical, like doing away with
the minimize, maximize and close buttons on the
window title bar, eliminating the window list and not
giving laptop users a choice of suspending to RAM
or suspending to Disk when closing the laptop
screen. There will also be a very loud group of
dissenters who will resist the changes that Gnome 3
delivers. At least under Linux, there are many more
choices for desktop environments (Xfce, LXDE,
FluxBox, OpenBox, e17, WindowMaker, etc.), and

Welcome From The Chief EditorWelcome From The Chief Editor

http://www.pclinuxos.com/forum/index.php/topic,87377.0.html
http://www.pclinuxos.com/forum/index.php/topic,87378.0.html
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those who choose to not adapt to the changes in
Gnome 3 will have the opportunity to explore those
other desktop environments.
It's looking, early on, as if the move to Gnome 3 may
not be much smoother than the move to KDE 4 was,
after all. In fact, the Gnome developers may not
have learned anything at all from observing the KDE
4 fiasco. There are already complaints among
Gnome users that the Gnome 3 developers are not
listening to the users. That's a situation that should
sound quite familiar to any KDE user. Of course,
there's always the "that's not me" and the "that was
them and how they did it; we're doing it differently"
mindsets among developers, when in reality, the end
results are the same. Sometimes it seems that
developers like to make change, just for the sake of
change. My boss at the hospital has a saying that
certainly rings true in this situation: "just because
you can doesn't mean you should."
Of course, as with anything else that's new and
evolving, it's always easy for those who don't do the
actual work to be a critic, and to sit back and take
pot shots at those who are doing the work. The flip
side of that coin is that users must be heard. They
are, after all, the ones who will be using the end
product, and if it doesn't do what they need it to do,
or if the changes are too radical, you will lose those
users. They will flee and use another desktop
environment that allows them to work as they are
accustomed to, and that isn't as radically different
from how users have used their computers.
One reviewer in the Linux press corps has what may
end up being the best approach to Gnome 3, and it's
quite similar to the approach of Texstar when making

the move to KDE 4. Wait it out. Let the dust settle.
See if the forthcoming changes in Gnome 3 actually
pan out with users, and see how many of those
eliminated features find their way back into Gnome
3. As you may remember, Texstar wasn't one of the
early adopters of KDE 4, due to its early buggy
releases. He chose to wait until it was more stable.
In fact, he took some heat for not making KDE 4
more available to PCLinuxOS users, and for going
with the more stable KDE 3.5.10 in the 2009
releases. This one reviewer speculated that the dust
should settle for the Gnome camp by version 3.2 (at
the earliest). Meanwhile, this particular reviewer is
exploring two options that KDE users has to choose
between a year and a half ago: keep his currently
working, stable Gnome 2.x going for as long as he
can, or use the opportunity to explore other desktop
environments, such as Xfce. Sounds familiar,
doesn't it?
There seems to be equal amounts of anticipation
and anxiety among Gnome users over many of the
changes that are coming. Even KDE users will be
looking on, to see if the Gnome developers "get it
right." It is definitely going to be interesting to watch
as the melodrama of the Gnome 3 release unfolds,
especially for Linux distros that primarily use the
Gnome desktop, such as Ubuntu and Fedora. Brace
yourselves. This could be quite a bumpy ride.
So, until next month, I wish each and every one of
you peace, happiness, tranquility and serenity.

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

Welcome From The Chief Editor

http://www.pclinuxos.com
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by coffeetime & smurfslover
Everything Module (from the website)
http://trac.enlightenment.org/e/wiki/Gadgets/
Everything
This is a plugin based module that offers a broad
number of tasks to perform, from running
applications, directory browsing, managing music
playlist, indexed file searching to browsing stuff from
youtube.
Basically, Everything is like a fancy kickoff, where
one can do everything using keyboard/key bindings,
plus adding interesting stuff like quick access to
Wikipedia, Google, YouTube, etc.
Some plugins can be
called up by setting a
trigger in the options, for
example, you can
configure it so you can
type a 'y' to activate the
YouTube plugin, type
what you want to search
for and Everything gives
you a list with titles and
thumbnails. However,
you will have to load
some of the modules.
Go to the Settings
Panel > Extensions >
Modules > Launcher
and load the ones you
want if they aren't
already loaded:

Everything configuration:
The default key to launch everything is ALT+ESC
To configure Everything, run it and type 'ev co', first
item should be 'everything configuration'.
Code:
ev co
When you get the following window, double click
Everything Configuration.

Here's an example. Let's add
YouTube:

Press Enter. You should get the configuration
window.

Click on Youtube to highlight it and check Enabled
on the right side. Apply.

e17: Configure The Everything Module To Do Everythinge17: Configure The Everything Module To Do Everything

http://trac.enlightenment.org/e/wiki/Gadgets/Everything
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You should see it in the main window. When it is
highlighted, press Enter.

Let's use it. For example type u2

Press Enter.

Use right arrow key and move to Wikipedia Page

Scroll down to Youtube

Press Enter. You should see something
like the next window (top right);

Right arrow key. Choose what you want. For
example, Watch on Youtube will open Firefox.

e17: Configure The Everything Module To Do Everything
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Many times, just typing in what you are looking for
will bring up the list and you can choose which one
you want, click on actions and choose your action.
Possible actions include watching your video on
Youtube or even downloading and saving it. In the
upper right corner of the window the launcher shows
the default action, click the word Actions to get a list
of possibilities. The chosen action will be defaulted.
If you want to configure Youtube, like setting or
changing the browser you want to use, click on
Configure.

When you do that, you will get the following window;

You can search for or browse through
­ Files and directories
­ Recently used files
­ Places
­ Apps
­ e17 settings
­ windows
­ desktops
­ commands you've run through the launcher
(exebuf plugin)
Other plugins:
­ Websearch: Google , Youtube (downloading and
converting), Wikipedia, ....
­ aspell spell checking
­ calculator (trigger is =)

­ mpris to control an mpris compatible media player
(banshee, exaile,...)
­ pidgin ­ open chats and send files
­ Wallpaper ­ change or import wallpapers
­ Tracker ­ support for tracker indexing service
(gnome indexing service using nepomuk)
(I wouldn't recommend using tracker if you want to
keep your e17 fast & light.)

You can configure Everything to run or open almost
anything. Once you start configuring it, you may use
it more than your normal menu. After you start using
it a lot, you will find that all your most often­used
items will be in the default window. All you will have
to do is run Everything and choose what you want to
use next.

If you arrow over to the Applications item (at the
bottom) and press Enter, you will get a list of your
most recently opened apps.

smurfslover said, "Since I discovered it and learned
to use it, I use almost nothing else; the menu just
becomes useless. It's very similar to KDE's krunner ­
it's fast and light and much easier to use."

Meemaw also contributed to this article.

e17: Configure The Everything Module To Do Everything

http://pclinuxos.com/?page_id=7
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by Meemaw
In the second part of our Scribus series, we did a
basic header, and got started putting news stories
into our newsletter. Since it is a newsletter, we
should have lots of text frames that contain our
stories. A few extra bits of knowledge will help make
our newsletter easier to assemble and, hopefully,
easier to read.
Title Shadow
When you created your
heading 'Newsletter' or 'Club
Newsletter' or whatever you
chose, I'm sure you found the
button in the text
configuration that would
automatically put a drop­
shadow on your text. The line
of buttons in Color & Effects
has Underline, Subscript &
Superscript and several
others, even Reverse. The
next to last button toward the
right is Drop Shadow.
However, we have found that
some of the pdf readers (kpdf for sure) have
problems loading and printing pdf's with the shadow
made in this manner. Some computer lock­ups have
even occurred. So, instead of just clicking the 'Drop
Shadow' button, we do ours a little differently. It
might take a few more seconds, but it is just as easy.
Make your text frame and get your title in it the way
you want it to look. My header at work is color, but
the background around the text is white, so my title
will be black with a gray shadow. After you get your

title the way you want it, click on Item > Duplicate.
Now you have two text frames with the same thing in
them. If the first was black, change the second one
to gray (or whatever color you want to use. For the
magazine, one is white and one is black.) Select the
one you want to be in front, and in Properties, click
on the up arrow with the line across the top of it
(bring to top). Note what the X­pos and Y­pos of your
text is, then choose the other text frame. Your drop
shadow can be in any position and as close or as far
away as you wish, just by manipulating the X­pos
and Y­pos of the other text.

My drop shadow here is done by adding 0.03 inches
to the X­pos and 0.02 inches to the Y­pos of the top
text. That makes the shadow underneath and to the
right of the main text. With some experimentation,
you can get them in many positions, close to the
main text or farther away, whichever you want. After
you get them positioned, you should group and lock

them so they won't get moved by accident. (You
could actually move these off the page and get them
positioned there if you wish. After they are locked
together you can move them back onto your page
and position them properly in the header, then lock
them to the page.) Save your work.
Text Flow
If one of your articles is rather long and it needs to
continue in another column or on another page, you
can do that with the Text Flow button.
First, you need to have
the article's text frames
already in place. (In the
illustrations, the text
frames have borders around them for visibility.) In
my newsletter I generally have two columns. Choose
the first text frame, then open the story editor screen
and put in your text. When you click the ok button
(checkmark) your story editor will close and you will
see your text in the frame. Since you have too much
text for that one frame, you will see a box with a red
X in the bottom right corner of your frame.

Using Scribus, Part 3: Text! Text! Text!Using Scribus, Part 3: Text! Text! Text!
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Click on the Text Flow button (hovering your mouse
over it will show 'Link Text Frames'), then click the
text frame where you want the rest of your text. You
should immediately see your text in that frame.

You can flow it to yet another frame, or resize the
two frames you are using, whichever works best for
your document. Just remember to click the frame
you are going from, then the Text Flow button, then
the frame you are going to.
Fonts
While we are talking about text, it might be a good
idea to mention that, although you want to 'dress up'
your newsletter, you probably shouldn't make it too
'busy'. What I mean is that there are thousands of
fonts you can use, some plain
and some fancy, but it's a
better idea if you stick to two
or three readable fonts for
most everything, and only use
one or two 'offbeat' fonts to
draw attention in a certain spot
in your newsletter. That way
you preserve the flow of the
newsletter while giving it an

added spark here and there. In my work newsletter, I
have used a couple of different fonts for article titles,
but left the standard font for the body of each article
so it's easy to read. The title font draws the reader's
eye, and then they read that article easily. Using a
different font for each article may sound good, but it
would distract the reader too much, so it is probably
best not to do it. After all, that's why you are doing a
newsletter; so people will read it.
Next month, we'll talk about layers.

Using Scribus, Part 3: Text! Text! Text!

Your Community Projects Forum

The PCLinuxOS Magazine
Created with Scribus 1.3.9

Advertisement

http://mypclinuxos.com/forum/
http://pclosmag.com
http://ibiblio.org
http://www.scribus.net


10

by Efstathios Iosifidis (diamond_gr)

Greece!!! The country where many people want to
visit the Acropolis and many other sites. But what is
happening on the FOSS area? There are plenty of
Linux Users Groups and distro communities, many
forums and blogs and only one printed magazine.
What about the famous distros? Ubuntu is organized
with a forum and mailing list (most of the users
migrate to Mint), Fedora has a mailing list and lately
they created their community portal and openSUSE
is a dynamic developing community with a forum
and mailing list. Finally, FreeBSD has a quite an
organized community. There are some other smaller
projects as well.

Unfortunately, LUGs across Greece promote only
Ubuntu. Their reason is quite simple. It comes all set
up complete with Greek documentation and help, it's
easy to use and, of course, it's the most famous.
Personally, I think the easiest distro is the one that
the user will start with. Most advanced users
characterize a distro as easy, compared to their
taste. A Windows user that wants Linux installed
must make the final decision. Some friends tell me
“things are easier with Windows, and there are more
programs (they mean cracked).” They claim that
“they don't use Linux because it's difficult and it's for
developers and hackers.” They express a negative
opinion for something they haven't even used. It's
difficult for me, (a Linux user), to prove to them that
Linux is easy.
Here comes PCLinuxOS. You all know the pros and
cons of the distro.
The next step is to promote and present it to many
people. How to do that?
1. Write to as many forums as possible.
2. Also write to blogs and magazines.
3. Translate some documentation to Greek

language.
4. Install it for many users.
5. Set a common place (forum, mailing list) where

questions can be asked, and maybe create
documentation for new users.

In my personal opinion, it's better to post in non­
Linux forums or blogs. That way Linux “earns” new
users. The advanced Linux users can search for
themselves about PCLinuxOS.

What I've done so far in Greece?
1. I have a blog under http://www.pclos.tk where I

add news, links to the magazine and
documentation. Maybe it's not the only one out
there. If so, other PCLinuxOS users can contact
me.

2. I write to as many forums as I can about the
magazine, documentation.

3. I write on the OSArena Blog (http://osarena.net),
which is one of the high traffic linux blogs. The
administrator wants to host the iso files and
maybe host a repository server, if possible.

4. I inform people about LUG's events.
5. I install PCLinuxOS for as many people as

possible, who want to migrate from Windows to
Linux, so I get questions asked and can create a
good documentation.

PCLinuxOS & Linux In GreecePCLinuxOS & Linux In Greece

http://www.pclos.tk
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Last month, the only printed magazine in Greece,
called Linux Format (Greek edition) changed to
Linux Inside (http://www.linuxinside.gr/). I didn't have
much time to contact them due to personal
problems, but I will soon.
So what needs to be done? First of all there must be
a Greek forum (it's better to be under the
international forum), where Greeks can find help.
The question is “Why create a Greek subforum?
There are not enough people”. The answer to this
question is that a forum is a tool for new users
where they can find help. Also, it will be a place
where all Greek users can gather, as there are not
many other Linux forums.
So what do new users think about PCLOS? What
are their reactions?
­ Can I do this? What about that?
­ Why isn't it more popular than Windows? It's so
powerful!

­ Why is it free? Is that legal?
Eliza T. (after using PCLinuxOS for two weeks)
comments:
Fast, flexible, easy to use, no fee to buy, many free­legal
programs. I feel comfort, I feel everything will be safe and
nothing will go wrong. That feeling is great because I'm a
person that I need my computer to do the basic tasks and
achieve various things on business and personal level.
Compared to Windows, PCLinuxOS gives me the
impression that it's radically simple and operational.

Maybe it has the same speed but I'm not sure yet since I
had an old version of Windows XP. I feel “strange” that I
don't use an antivirus program and many other programs
to protect my computer after many years I used Windows.
To be continued soon!!!

Screenshot ShowcaseScreenshot Showcase

Posted by coffeetime, February 18, 2011, running WMii.

PCLinuxOS & Linux In Greece

http://www.linuxinside.gr/
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by Meemaw
The last four sections in the Settings Panel are
Advanced, Settings, Extensions and System.
Advanced

ACPI Bindings ­ This is a configuration you can uset
o tell the system what to do for certain keystrokes.
For example, you can designate that the computer
be suspended or shut down immediately if the power
button is pressed. You can also choose what you
want to do if your laptop lid is closed (shut down or
hibernate or suspend). There are several defaults
already in place.
Performance ­ Sets things like frame rate and
cache size.

Search Directories ­ Sets the default directories for
data, images, icons, themes, fonts, modules and
backgrounds. You can change or add locations.
Engine ­ Enables or disables Composite
Configuration Panel ­ You can configure the whole
Settings Panel to appear in your menu if you wish.
You will get a menu item under Settings called 'All'
which will have each section in the settings panel.
Settings

Dialogs ­ Confirmation dialogs can be enabled or
disabled here.
Profiles ­ Profiles are different screen configurations
you can choose, from default to minimal, and even
for a phone or touchscreen. There is a short
explanation for each.

Extensions

Modules ­ Many of the modules you will use are
already loaded. However, others (like Drawers) need
to be loaded and you do it from here. It comes up as
a small window, but enlarge it because the majority
of your module loading and settings are in this
window.
Screenshot ­ Your e17 installation has a screenshot
program already on a shelf...(unless you removed it.)
It can be configured here.
Shelves ­ New shelves can be added and
configured from here.

e17: Settings Panel, Part 3e17: Settings Panel, Part 3
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Mixer ­ Designates which sound card to use, and
will launch the mixer so it can be configured.
Pager ­ Configuration for your pager (multiple
desktops.)
Everything Configuration ­ This starts the
configuration for Everything, which is a 'plugin­based
application' that lets you run almost anything.
Itask NG ­ This a more advanced taskbar and app
launcher, with zoom effect.
Everything Plugins ­ Configure which plugins you
want to use
Everything Start ­ There is a gadget called
Everything Start which you can load. It puts an icon
on your desktop which will start Everything with a
single click.
Everything Files ­ This is to edit your recently
opened files list in everything. You can clear the list
and start over if you wish.
Everything Applications ­ For configuring which
applications should be included.
Everything Aspell ­ Aspell is a spell checker which
can be one of the applications you run in Everything
Everything Websearch ­ If you add the websearch
module, this configuration item will show up in the
section, allowing you to configure it.
Gadgets ­ Extra gadgets can be loaded and
configured here.

System
This section contains many of the same things that
PCLinuxOS Control Center (Configure Your
Computer) includes. You'll need to enter your root
password on many of them.

Network Center ­ Configuring your Internet
connection.
Firewall Setup ­ Configure your firewall.
HP Device Manager ­ Help with your HP printer
GDM Login Setup ­ Configure your login screen to
show a certain wallpaper, and what you want it to
include.

Repository Speed Test ­ You can run this to find
the fastest repo for updating using Synaptic.
NTFS Configuration Tool ­ Configure your system
to read the NT file system used with Windows
Authorizations ­ You can use this section do
designate which user is authorized to perform some
functions, such as killing a process or unmounting a
drive.
Although it's not in the picture, after I updated
through Synaptic, the following item appeared in this
last section;
Update Package Sources List ­ I haven't tried it so
I'm hoping it does just what we all had to do in a
terminal not long ago when the repos changed.
Have fun with e17!!!

e17: Settings Panel, Part 3
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by ms_meme (In her own words)
Editor's Note: This month, we feature our beloved ms_meme in our spotlight of the
Ladies Of PCLinuxOS column. In typical ms_meme style, she provides her own
"interview" of sorts, in her own way, and in a way that you would expect ms_meme to
respond: in a poem.

Ladies Of PCLinuxOS: ms_memeLadies Of PCLinuxOS: ms_meme

ms_meme martha marty to me it's all the same
Married 39 years to one man who gave me my last name
Two grown children each with a computer science degree
Whatever interests them always interests me
Got my first computer the date was Y2K
I never knew the difference just another day
In 2008 to Linux I decided to change
Looking back that other seems so very strange
I might be like a palm tree some say just the nut
To fun and new activities my mind is never shut
Or perhaps a daisy flower whose petals are a lot
And I toss out any new things if they love me not
The New PCLinusOS Magazine said meme we want you
Ok I replied but there's only one thing I can do
So they put me in a corner called ms_meme's Nook
To sing PCLinuxOS praises but never by the book
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Answers on Page 24.

Double Take & Mark's Quick Gimp TipDouble Take & Mark's Quick Gimp Tip

The Gimp allows you to adjust an image in
a multitude of ways. You can crop, align,
resize, flip, brighten, darken, etc. I make
frequent use of the rotate tool when I'm
creating my comic features. (I sometimes
need to straighten the artwork after
scanning, or I simply want to adjust an
element within the comic panel.) The
Gimp's rotate tool is very versatile and
easy to use. You can rotate a layer,
selection or path. I especially like it's
ability to change the pivot point of the

Mark's Quick Gimp Tip
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image being rotated. When
you select an image or area to
be rotated, you're presented
with the marching ants outline
defining the selection, and a

cross­hair in the middle of the selection.
Simply move this cross­hair anywhere
within the selected region and it then
defines the point from which the image is
going to be rotated. In the example at right,
I moved the cross­hair to the lower left of
the selection. You can see how the image
is then rotated up and to the left, but the
cross­hair point stays stationary.
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­Mark Szorady is a nationally syndicated cartoonist with georgetoon.com. He blogs at georgetoon.com/blog. Email Mark at georgetoon@gmail.com.

Simply movethe crosshairto define thepivot pointwhen rotatingan image.

http://www.georgetoon.com
mailto:georgetoon@gmail.com
http://www.gimp.org/
http://www.georgetoon.com/blog
http://www.gimp.org/
http://www.gimp.org/
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by Darrel Johnston (djohnston)

The e17 window manager has plenty of eye candy.
One aspect that was missing for some time was a
3D desktop display, such as Compiz. Because the
enlightenment libraries aren’t compatible with
Compiz, the more adventuresome e17 developers
set out to create their own 3D display manager.
Their creation is called ecomorph.
The e17 creators state that e17 will run on a PC with
as little as little as 64MB of RAM, a 100mHz CPU,
and a VGA video card capable of 640x480
resolution. However, that is cutting it very close. I’m
going to err on the side of caution for a PC running a
PCLinuxOS version of e17 and a version of e17­
Ecomorph.
For the full e­17 version, which is based on KDE4
and Qt libraries, I would recommend a minimum of
512MB of RAM, a 500mHz CPU, and a video card
with 32MB of video RAM. The light e­17 version,
based more on Gtk+ libraries, would need 256MB of
RAM and a video card with 8MB of video RAM.
However, either PCLinuxOS e17 version running an
e17­Ecomorph desktop session would need at least
a 3D­capable video card with 32MB of RAM, at the
absolute minimum. And that may be stretching it a
bit. Ecomorph is a modified version of Compiz, so a
3D­capable video card is a necessity. An nVidia card
is also recommended. ATI may work, but I don’t
have one and cannot verify whether it will. Intel
embedded graphics chipsets would not be
recommended. As a general rule of thumb, if you

can run Compiz on your PC, you can run e17­
Ecomorph.
In order to run ecomorph, there are some software
prerequisites. The first, of course, is an installed e17
desktop. The second is the ecomorph package. A
Synaptic search for the terms “e17” and
“enlightenment” will not show the ecomorph
package. Search for the package in Synaptic by its
name, then install it.

The third prerequisite for running ecomorph is the
ecomp package. Once again, a Synaptic search for
the terms “e17” and “enlightenment” will not show
the ecomp package. Search in Synaptic for the
package by its name, then install the package.

After the ecomorph and ecomp packages are
installed, we can begin configuring ecomorph. First,
be sure Compiz is not running. Open the
PCLinuxOS Control Center, click on Hardware in the
left panel, then click on Configure 3D Desktop
effects in the right panel. Be sure “No 3D desktop
effects” is selected.

For the next step, go to the PCLinuxOS menu,
select Settings > Modules. Click the System tab at
the top of the window. Select the Ecomorph module,
then click the Load button at the bottom.

e17: Running Ecomorph, Part 1e17: Running Ecomorph, Part 1
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Click the Look tab at the top of the Module Settings
window. For ecomorph to work correctly you need to
disable the Composite and Dropshadow modules.

Close the Module Settings window. From the
PCLinuxOS menu, select Settings > Ecomorph. Do
not click the Start Ecomp button. Ecomorph will be
started later by logging out, then changing the
desktop session to Ecomorph. When you login to the
Ecomorph session, Ecomorph should be running out
of the box. Next, tick the Ecomorph Mode box just
above the Start Ecomp button. Then, click the Apply
button at the bottom of the window. The screen may
flash for a second or two. If the Apply button at the
bottom of the window is selectable again, click it.
I now want to enable two particular 3D effects, Expo
and Cube. The Base Plugins were already all
enabled. I left them as is. In the Viewport Plugins
section, I enabled Plane, Cube, and Rotate. In the
Switcher Plugins section, I enabled Ring Switcher,

as I want to use that option later. In the Other
Plugins section, I enabled Wobbly (windows effect)
and Cube Reflexions. Then I saved the settings by
clicking the Apply button.

In order to use the Expo and rotating Cube effects, I
need to add Key or Mouse Bindings. From the
PCLinuxOS menu, select Settings > Settings Panel.
At the top of the Settings window, click the right
arrow button to scroll the tabs until the Input tab
appears. Then select the Input tab. For the Expo
effect, I chose to use key bindings. Select the Key
Bindings button.

I wanted to use key combinations which were easy
for me to remember. irst, I scrolled down to the
CTRL+ALT section in the left window column to see
if the E, N and P combinations were already in use.
They weren’t, so I chose those. First, click the Add
Binding button in the lower left corner of the window.
A small message appeared (not shown) stating to
“Please press key sequence or Esc to abort”. I
pressed Ctrl­Alt­E. To assign the key sequence to an
action, I scrolled down in the right column of the
screen to the Ecomorph section. I clicked the Expo
Initiate button to assign the key sequence. I wanted
to be sure the setting was saved, so I pressed the
Apply button.

Advertisement
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Moving on the to the next key sequence, I clicked
the Add Binding button, and pressed Ctrl­Alt­N. I

then clicked the Expo Next button in the right
column, then clicked the Apply button.

For the last Expo key sequence, I clicked the Add
Binding button, then pressed Ctrl­Alt­P. I then clicked
the Expo Prev button in the right column, then
clicked the Apply button to save the key sequence
settings.
To activate the Cube effect, I chose to use a mouse
binding. From the Settings window, with the Input
tab selected, click on the Mouse Bindings button. I
chose a Ctrl­Alt action again. First, I clicked the Add
Binding button. A small dialog window appeared
explaining how to input the mouse selection, or to
“Press Escape to abort”. I pressed Ctrl­Alt on the
keyboard, then the right mouse button. Note that the
selection shows the mouse button first (Right
Button+CTRL+ALT). In the right column of the

window, there are no cube options in the Ecomorph
section. Using the method posted on the forum by
rpmTECH, I clicked Custom Action in the right
column. In the lower right corner of the window, an
Action Params input box appeared. As per
instructions, I deleted the default text in the input box
and entered 0 5 0 0 0. I then clicked the Apply button
to save the mouse binding.
Once I had finished adding the Ecomorph settings I
wanted to use and test, it was time to try them out. I
closed all open windows, then logged out. At the
login window, I selected E17­Ecomorph session,
then logged in with my username and password.
The screenshot below (next page) shows the Expo
effect.

e17: Running Ecomorph, Part 1
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The screenshot below shows the familiar rotating
Cube effect.

There are many, many special effects configuration
options available in the Ecomorph Configuration
window. In the next article, I will delve into some of
them.

Special thanks go to Agust and smurfslover for their
many e17 and Ecomorph tips and tricks in the
forum.

Screenshot ShowcaseScreenshot Showcase

Posted by ghostbunny, February 2, 2011, running LXDE.
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Forum Foibles: Roman HolidayForum Foibles: Roman Holiday

'Twas the middle of February the weather still was cold
The posts in the forum were stale and getting old
Synaptic was broken so no one could update
The bacon was rancid just sat there on the plate

Texstar counting his money said "Hip Hip Hurray
I'm inviting everybody for a Roman Holiday"
The forum was a twitter as they started to pack their bags
"Nothing to wear "said the gals "all we have is rags"

"Not to worry" said our leader "because all that you need
Is an old Roman name and then you may proceed"
You can tell by the tags we really went gung ho
Had a lot of fun spending all Texstar's dough

PCLinuxOS users are really a great bunch
They're game for anything if someone pays for lunch
The memories that we share nothing else can compare
We enjoy it all and never ever leave our chair.
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by Paul Arnote (parnote)

I have to be perfectly honest. I do have a computer
with WinXP on it still in the house. It's there for one
special reason: to record television programs for
later viewing, and to edit videos. Until quite recently,
I had not been able to find a suitable Linux
application to perform either task. Most "television"
applications in Linux, like the popular TVTime, allow
you to only watch television programs. Sure, some
applications exist to allow you to record television
programs, but only after you've earned your PhD in
that application are you then able to perform (what
should be) this relatively simple task. As for editing
those video recordings, the tools are definitely there
(and have been all along), but it isn't until you dig
deeper into these tools that you uncover their hidden
(and often well disguised) capabilities.
While I'm being honest here, the lack of support for
video recording (from a TV tuner card, or otherwise)
in Linux, along with the lack of adequate video
editing software, has been a "sore spot" for me ever
since I started with Linux over four years ago. Before
I was "enlightened," back when I was a Windows
user, I was knee­deep into video recording and
editing. When I started with Linux, there was virtually
nothing that allowed me to perform these tasks –
tasks that I had become accustomed to performing
with my computer.
Our Windows counterparts, like it or not, have a
much easier time with both of these tasks. There are
many, many choices for video recording
applications, as well as many, many options for
video editing applications. Our OS­X brethren (I call

them brethren, since OS­X is somewhat based on
BSD, another *nix­like system) also have a lot more
choices for well written applications to perform these
tasks. Meanwhile, we Linux users are the red­
headed step­children of the software world, when it
comes to video recording and editing applications.
So, like any self­respecting Linux user, I sought to
find solutions to these problems, these, these
software omissions. Being the self­respecting Linux
user that I am, the kind who cringes and feels "dirty"
whenever he has to use a Windows computer in his
own home, I did the only thing I could do, after not
finding any suitable video recording applications: I
made my own. I also have to admit that I was
inspired to see this through by Leiche's efforts on his
MyMencoder application (which we'll be taking a
look at next month, by the way).

PCLinuxOS PVR
Amazingly enough, it wasn't as difficult to make the
recording application as I had thought it would be.
PCLinuxOS PVR (Personal Video Recorder) is
simply a bash script that's been dressed up with a
GUI, thanks to gtkdialog. Take a look, and see what
it looks like (top of the next column).
PCLinuxOS PVR can be installed on your computer
running PCLinuxOS, via Synaptic.
Before we can record video from our TV tuner card,
we first have to pass some instructions and
parameters along to control the resulting video file.

Selecting Video Input Device & Channel

At the top of the window, we select the video
recording device. Some users may have web cams
attached to their computers, and others won't. Some
users may even have two TV tuner cards installed
on their computer. Because there is no way to

Video: Part 1 - Time Shifting TV ProgramsVideo: Part 1 - Time Shifting TV Programs
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predict the wide variety of hardware configurations a
user may have, the user will have to select which
V4L or V4L2 (Video For Linux and Video For Linux
2) device they want to use to record from. This also
allows the user to record from their web cam (if they
choose), since the user has the ability to choose that
web cam as the input source for their video
recording.
On my system, the TV tuner card is labeled as
/dev/video0. If you don't know how the label for your
TV tuner card (or any other video output device) on
your system, open a terminal and simply type lshal
|grep video on the command line. Scroll back
through the output, until you find the line
linux.device_file =. The information on the right side
of the "=" is the label for your video output device.
We also have to tell the TV tuner card what channel
to tune to so we can capture our video. In my case,
since I'm recording everything from a digital cable
converter box, my channel is always set on channel
3. Obviously, if you are recording off­the­air
programming using rabbit ear antennae or an
external TV antenna, you will need to specify the
channel that you wish to record from.

Encoder Settings
In the next section of the PCLinuxOS PVR window,
we need to pass along some parameters to control
our video recording.
The first entry is "Video Bitrate." Before you go and
automatically choose the highest video bitrate you

can, a word of caution is in order here. The higher
the video bitrate, the higher the quality of the
recorded video. But that also means that you will
have a MUCH larger file. Higher video bitrates =
higher quality video files = larger video file sizes.
PCLinuxOS PVR defaults to a video bitrate of 300
kbps. This results in a small file, but also one with
quite marginal video quality. Videos recorded at this
low video bitrate are suitable if you are recording a
television program to view later on your computer
monitor, and you're not looking to save it. If you are
looking for better quality video (say, you want to
record it to DVD later on), video bitrates between
1000 and 2000 kbps typically give pretty good
results, and allow you to fit close to 4 hours of video
onto a DVD. If you are looking for the best quality
video, then video bitrates of 5000 kbps and higher
are what you are looking for. You can enter any
number you want here, but I definitely would not
recommend entering a value less than 300 kbps, nor
higher than 8000 kbps. The easiest is to simply
select a video bitrate from the drop down list that is
provided.
Below is an example of the output of a video
recorded with PCLinuxOS PVR, recorded at 2000

kbps video bitrate, played back in the Xfce Parole
Media Player.

Under the second entry, "Frames per second (FPS),"
you can set the frames per second that is used for
your region of the world. In the United States and
Japan, NTSC is the standard, and it presents video
at 29.97 frames per second. In most of Europe, PAL
is the standard, and it presents video at 25 frames
per second. Films are typically shot at 24 frames per
second. Can you see how confusing this becomes?
It gets even worse when you factor in HD
recordings. For now, just choose the frame rate that
is most suitable for your region of the world.
The next entry, "FourCC," can be skipped for now. It
has not yet been fully implemented. The FourCC
code is used exclusively by the AVI file format, and
identifies the codec used. Once implemented, this
will allow users to record video that can be played
back on a DVD player that recognizes and plays
back DivX encoded AVI files. Many DivX encoded
AVI files will fit about 2 hours of decent quality video
on a regular CD­R. Also, users who choose to use

Video: Part 1 ­ Time Shifting TV Programs
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XviD (an open source alternative to DivX) can "trick"
those DVD players into thinking it's a DivX encoded
AVI file, merely by changing the FourCC code.
The fourth entry, "MP3 Bitrate," allows you to set the
quality level of the sound you record. The default
value is 128 kbps, which typically produces
acceptable stereo quality sound. Just as with the
video bitrate discussion above, the higher the MP3
bitrate you set, the larger amount of space (within
the video file) your sound will occupy, but also
resulting in a higher sound quality. Fortunately, the
sound of a video only occupies a fraction of the
space within a video file, compared to the video.
This entry field allows you to either select from the
preset values in the drop down list (128, 160, 192 or
256), or enter your own MP3 bitrate. Currently, the
MP3 sample depth in PCLinuxOS PVR is locked at
41,400 Hz, or 41.4 KHz.
While I'm talking about the audio, let me give you a
tip here. My TV tuner card has a stereo patch cord
that outputs the audio from the card to the Line In
input on the sound card. If you start getting video
recordings without sound, check to insure that you
have your Line In capture activated in your audio
manager.
Under the "Format Container" entry, I recommend
(for now) just leaving it set for AVI. I have future
plans to include the ability for the user to choose to
record video as MPEG 1, MPEG 2 and Ogg­Theora
(*.ogv) files. It is not yet fully implemented at this
time.
Under the final entry, "Select a recording length
(minutes)," you set how many minutes you want to

record from your TV tuner card (or other video
output source). Enter ONLY minutes here, and enter
ONLY whole numbers. Thus two hours becomes 120
minutes. Four hours becomes 240 minutes. Three
hours and 36 minutes becomes 216 minutes. You
can either select from the preset recording lengths
listed in the drop down list, or enter your own values.
Your recording will automatically terminate after the
number of minutes you specified has elapsed.

The "button" controls

At the bottom of the PCLinuxOS PVR window are
the buttons that control the starting and stopping of a
recording, along with exiting the program and getting
more information about PCLinuxOS PVR.

The "About" button brings up the dialog shown
above.
Selecting the "Record Video" button starts the video
recording at the instant that you click it, and using
the parameters you specified in the "Encoder
Settings" section of the window.
If you want to stop a recording before the specified
amount of time has elapsed, simply click the "Stop
Recording" button. Your recording will immediately
cease.
Selecting the "Exit" button exits the PCLinuxOS PVR
application.

Future Plans
I've already revealed some of my future plans for
enhancing PCLinuxOS PVR: implementation of the
FourCC code, and the ability to record to video file
formats other than just AVI. I also want to allow the
user to choose the MP3 sample depth (48,000, or 48
kHz audio is typically required for DVD authoring).
The really big thing to add (and most important, at
this point) is the ability to set up timer recordings. In
its current state, you have to be sitting in front of
PCLinuxOS PVR to start the recording. What I want
is the ability to set a timer to record a program in the
future, without the user sitting in front of the
computer, and without any additional user interaction
with PCLinuxOS PVR. With this addition, it will be
possible for you to set a timer that will automatically
record Wheel of Fortune on Friday evening, while
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you are out having dinner with your family. When
you return from dinner with your family, you can sit
and watch Wheel of Fortune at your leisure, just as
you can with a VCR or DVR. I am beginning to get
my head wrapped around all the stuff that is needed
to implement this feature (believe it or not).

Summary
As you can see, PCLinuxOS PVR has the potential
to grow, and I'm currently working on implementing
that growth. Still, as it sits today, it gives me
something that I never had before: an easy to use,
reliable way to record quality video from my TV tuner
card, with minimal effort. Sure, it only records in the
AVI format at this time, but it gives me more than I
had before, which was nothing. That alone is a
milestone, at least for this Linux user.
See? There's not much that a self­respecting Linux
user can accomplish, once he or she puts their mind
to it. Sometimes, it just takes an unwillingness to be
shunned by the rest of the computing world to spark
those accomplishments.

Answers to Mark Szorady's Double Take:
(1) Hair shorter; (2) Bowtie missing; (3) Tooth missing; (4) collar missing; (5) Word balloon
different; (6) “information” changed to “inform”; (7) Shirt cuff missing

Screenshot ShowcaseScreenshot Showcase

Posted by coffeetime, February 8, 2011, running Phoenix­Xfce.
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by Paul Arnote (parnote)

In January, Sproggy launched a new PCLinuxOS
forum. No, don't worry. Your regular forum hangout
hasn't changed. It hasn't even moved. This new
forum is targeted at kids.
Since there are a number of PCLinuxOS users with
kids, Sproggy thought it would be a good idea to
have a safe place where those kids could hang out
and socialize with the kids of other PCLinuxOS
users. Sproggy is hosting the forum on his own
website.

Since getting started, PCLinuxOS Kids has grown to
include 20 regular members, so far. Four moderators
help maintain order in the forum, insuring that the
short list of rules is adhered to. Those moderators
are blindschLeiche, GuypronouncedGuynotGuy,
longtomjr and SproggyJnr2. As you might imagine,
longtomjr is the son of longtom, and SproggyJnr2 is
the youngest son of Sproggy. The forum has three
administrators to assist with the day to day running
of the forum. Those administrators are longtom,
Sproggy and parnote.
As you can see (left), the forum is currently broken
down into three areas. The first lists the few simple
rules of the forum. The plan is to keep the rules
minimal and simple, at least to start off.
The second area is the "Fun" area, where
discussions can occur about favorite games,
graphics, jokes, movies and sports. Thus far, forum
members can be found sharing their latest graphic
creation, as they learn about the various graphics
tools available in PCLinuxOS, or sharing their latest
favorite jokes.
The "General Category" fills in the third area of the
forum. Here, general discussion of just about
anything and everything occurs. Users there have
already expressed an interest in expanding the
areas of the board to include a coding section,

where they can help one another learn various
coding techniques and share tips and tricks of
coding.
Of course, you don't have to actually be a kid
yourself to join the PCLinuxOS Kids forum. This
forum appeals to the "kid" that exists in all of us, and
is open to "kids" of all ages. Feel free to join in on
the fun. Plus, if you have kids of your own and you
are looking for a safe place where your children can
socialize with others their own age, they are more
than welcome to join in on the fun, as well. After all,
the kids are our future. The earlier we help them to
get started with PCLinuxOS, the better prepared
they will be whenever they head out on their own ...
and the better prepared they will be to carry the
PCLinuxOS legacy into the future.

LinPC.us

The PCLinuxOS Kids logo created by longtomjr.

New Forum Launched: PCLinuxOS KidsNew Forum Launched: PCLinuxOS Kids
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by Paul Arnote (parnote)

Once you have finished recording your new video
from your TV tuner card, you will most likely want to
edit it. I'm not too sure about you, but I can barely
stand to sit through all of the commercials one time,
much less multiple times. Do you remember how, in
Part 1, I talked about some Linux applications that
have well­hidden, and often well disguised,
features? Well, I found one, that once you figure out
how to unleash its capabilities, works as well as (if
not better than) anything offered in Windows.
In fact, one of the Windows programs that I still
relied on was a video editor called Video Redo. Up
until very recently, I didn't find anything in Linux that
performed in a similar manner. Video Redo focused
mostly on being able to edit MPEG1 and MPEG2
video files, without re­encoding the output video.
This is a huge consideration, since re­encoding the
video can result in a loss of quality. Each time a
video is re­encoded, more and more details are lost,
since the compression algorithm is applied with each
re­encoding. It's just like if you keep saving the same
JPG image over and over again, recompressing it
with each pass. After only a few passes, the quality
of the JPG image starts to noticeably deteriorate,
due to recompression artifacts becoming more and
more visible.
A large number of users have been asking the
makers of Video Redo for a Linux version of the
program for over five years. Despite one of the
developers moving to Linux during that time, and
another moving to the use of OS­X as his primary
OS, Video Redo remains firmly entrenched as a

Windows­only application. Unfortunately, there are
mixed reports of being able to run it under Wine.
This is where Avidemux comes to the rescue. If you
set it up properly, Avidemux will perform the exact
same task as Video Redo. In fact, I've found it easier
to use than Video Redo for clipping out the
commercial advertisements from recorded TV
programs. As an added benefit, Avidemux will open
and edit almost any video file that you are able to
view on your desktop, and not just MPEG1 and
MPEG2 files, as Video Redo restricts itself to. Sure,
there are other video editors for Linux, like Cinelerra,
but the complexity of Cinelerra makes it overkill for
what we want to do. The number of Linux users who
have taken a look at Cinelerra and ran the other
direction screaming with horror, are legendary. I'm
firm in my belief of the K.I.S.S. principle (Keep It
Super Simple), and Avidemux fits within those
beliefs quite nicely.

Some background
Under Windows, video editing applications came in
two basic flavors: time­based editors and frame­
based editors. For editing the commercial
advertisements from time shifted recordings, time­
based editors just don't work well. What you really
need is a frame­based editor. These are a lot harder
to find and tend to cost more than the time­based
editors (remember, you have to buy software for
Windows). To understand why frame­based editors
outperform time­based editors, you have to have a
basic understanding of how video is stored in a
video file. There are some subtle differences
between the various formats, but the general

principle applies to all. The explanation that follows
is only a general overview. Realize that this
information is much more detailed than what I
provide below. If you want to learn more about the
structure of various video files, visit VideoHelp.com
or Doom9.net.
The video image is created as a GOP, or Group Of
Pictures. Within that GOP, there is the GOP Header,
followed by the I­frames, B­frames, and P­frames. I­
frames are basically "index" frames. That means that
the I­frame is encoded as a single image, with no
reference to any other frame, past or future. B­
frames, on the other hand, are bidirectionally
predicted from the preceding and subsequent
frames. Basically, only the bits that change are
recorded, resulting in B­frames saving the least
amount of data, helping to reduce file size.
Meanwhile, a P­frame is a video frame that is
encoded relative to the past reference frame, which
can be either another P­frame or an I­frame,
depending on which frame is the closest preceding
reference frame.

With time­based editors, video is
typically cut at the closest
reference frame to the time that
you choose, either the I­frame or
P­frame. You might not think that
this would make a huge
difference, since there are
typically a set number of frames
per second within a video file,
depending on the broadcast
standard used in your area of the
world. However, programming
content that is recorded from
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over the air (or cable) broadcasts has the
commercial advertisements inserted without regard
to the video reference frames. Thus, more often than
not, you either get the last small bit of an
advertisement or you chop off the first part of the
video you are attempting to save. You can liken it to
trying to stop an hour glass's flow on a particular
grain of sand. Trust me. It doesn't result in "clean"
edits.
Now, with frame­based
editors, you can make
your edits on any frame
of the video. Thus, if the
broadcast image fades to
a commercial that does
not occur at a reference
frame, you can still make
precise cuts, eliminating
the "flash" of the last
fraction of a second of an
advertisement that precedes your cut point. With
frame­based editors, you can make much cleaner
edits. Video Redo and Avidemux fall into this latter
category of video editors.

Chop, Chop! Editing With Avidemux
Avidemux is an open source, cross­platform, multi­
format video editing application, with versions
available for Linux, Windows, Mac OS­X and BSD.
Almost without exception, if you can play a video file
on your computer, Avidemux can edit it. It is
available in the PCLinuxOS repository as a
command line tool, with a Gtk+ interface, and with a
Qt4 interface. Since I'm using Phoenix Mini (Xfce),

my screen shots will feature the Gtk+ version. The
Qt4 version is identical in functionality to the Gtk+
version.

Keep in mind that this is not going to be a full­blown
Avidemux tutorial. Rather, for now I'm only going to
focus on the use of Avidemux to edit the video that
you might have recorded from your TV tuner card.

The key to preserving the video quality is displayed
in the screen shot above. Set both Video and Audio
to "Copy" (circled with the red ovals). This prevents
both the audio and video from being re­encoded
when you save the file, and simply copies the audio
and video data to the new video file, without
recompressing the output. Re­encoding will cause
the video to be recompressed, which is something
we do not want to happen, since it will most likely
result in a loss of quality from compression artifacts.
You can always choose to recompress the video
later, after you've made your edits. In this way, it's
similar to doing all of your edits on your graphics
files in the PNG format (which uses lossless
compression), and then saving your final version as
JPG (which uses lossy compression) to achieve the
smaller file size that JPG graphics provide. The goal
is to minimize the introduction of those compression
artifacts, which become increasingly visible with
each pass through a lossy compression algorithm.
For what it's worth, virtually all video compression
algorithms use lossy compression. Otherwise, the
file sizes would be many, many times larger than
they currently are.

Video: Part 2 ­ Editing Your Recorded Video
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The six keys highlighted with red are all you need to
successfully navigate through a video file with
Avidemux. Of those, there are only four that I use
the majority of the time: Shift, Control, Left Arrow
and Right Arrow. I find that I have much more
precise control of my positioning within a video file
by using the keyboard over the mouse. Pressing the
left or right arrow keys steps backwards or forwards
(respectively) through a video one frame at a time.
Shift + Left arrow moves backwards in the video file
25 frames, while Shift + Right arrow moves forwards
in the video file 25 frames. Ctrl + Left arrow moves
backwards in the video file 50 frames, and Ctrl +
Right arrow moves forward in the video file 50
frames. Pressing the Up arrow key moves to the
next key frame in the video file (Shift and Ctrl have
no apparent affect on this action), while pressing the
Down arrow key moves to the previous key frame in
the video.
I tend to use a combination of the key presses I
described to get me close to the edit point in a video.
Once I get close, I then use the Left arrow and Right
arrow keys to make the fine adjustments, and to
bring the video right to the frame that I want to start
my cut.

There are similar controls on the Avidemux control
bar. From left to right, the buttons are: Play/Pause,
Stop, Previous frame, Next frame, Previous key
frame, Next key frame, Start selection, End
selection, Previous black screen, Next black screen,
Beginning of file, End of file. You could use the

mouse and navigate through the file using repeating
mouse clicks on the appropriate buttons, but it is
much easier to use the keyboard to navigate through
a file. For what it's worth, I find that the "Previous
black screen" and "Next black screen" buttons don't
really work all that well. It is slow to search through a
large video file for the black screens, and Avidemux
only seems to find them when the black screen that
precedes a commercial advertisement falls on a
reference frame within the video. The majority of the
time, that does not occur.
When you come to a section of the video that you
want to cut out (such as the start of commercial
advertisements in the middle of a video), use the
Left or Right arrow keys to navigate to a black
screen right before the advertisement, and select the
"A" button to mark the beginning of the selection.

Now, navigate to the end of the advertisements, to
the black screen that immediately precedes the
resumption of the video you want to keep, and select
the "B" button to mark the end of the selection. Once
you have the start and end of the commercial block
marked (indicated by the brackets superimposed on
the video position slider), simply press the "Delete"
key on your keyboard. Voila! The commercial block
is gone. Repeat this process throughout the rest of
your video file for each of the commercial blocks that
you want to edit from your finished video. When you
are finished, you'll have your own copy of the movie
or television show, free of commercial
advertisements.

Don't worry if you make a mistake, since none of
your edits are committed to the file until you
specifically tell Avidemux to save your file. Simply
reload your video and start over. The entire process
is very easy, and you'll have the hang of it quite
quickly.

Once you reach the end of the file, then save your
video with a new name. You will want to do this, just
in case something gets messed up during the save
file process, or you later discover that your edits
weren't exactly correct. If you use a new file name,
you can always go back to the original and repeat
the process to make things "right." You can always
delete the original file at a later time, after you are
sure that your edits are correct and as you like them.
Sit back and wait while Avidemux saves your new,
commercial free video file. While you are waiting,
you can watch the progress in the dialog box
(above) that appears. Remember that video files are
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quite large, so it does require a bit of time to work
with them and to save them. Also remember that the
longer the video file (say a two hour movie, versus a
30 minute sitcom), the longer it will take to process,
since we're talking about 4x as much data in the two
hour movie, compared to the 30 minute sitcom.

Summary
Avidemux is one of those Linux gems with hidden
talents. As you can see, it's relatively easy to
perform frame based edits on a video file, without
having to re­encode (and potentially degrade) the
video. Now that I have discovered Avidemux's
hidden abilities (well, they were hidden to me until I
starting digging into it), I have finally found a very
capable replacement for the last Windows
application that I relied upon, Video Redo. With a
free, open source solution available, I couldn't care
less if the Video Redo developers ever make a Linux
version of their commercial application. Avidemux
suits my needs perfectly, as I'm sure you will find it
able to perfectly meet your video editing needs.

Looking for an old article?Can't find what you want? Try the

PCLinuxOS Magazine'ssearchable index!

Screenshot ShowcaseScreenshot Showcase

Posted by El Gallo del Cielo, February 6, 2011, running Zen­Gnome.
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by Paul Arnote (parnote)

Less than five months after the creation of The
Document Foundation, LibreOffice 3.3 has been
released. As with many Linux distributions,
LibreOffice has become the default office suite in the
PCLinuxOS repository. The Document Foundation
has spent their time well, and have made several
enhancements to the free office suite.

Background
On January 27, 2010, Oracle acquired Sun
Microsystems. For the previous 10 years, Sun
Microsystems had developed and maintained a
whole suite of free, open source applications that
included OpenSolaris, VirtualBox and OpenOffice.
On August 13, 2010, an internal Oracle memo was
leaked that spelled the end of OpenSolaris. As you
might be able to imagine, this sent shockwaves
throughout the FOSS (Free Open Source Software)
community. Fear grew that Oracle would also
abandon OpenOffice.

On September 28, 2010, several developers of
OpenOffice formed The Document Foundation. The
new foundation received backing from Google, Red
Hat, Novell, Canonical, and others. Despite being
invited to join the new foundation, Oracle chose to

have nothing to do with sponsoring The Document
Foundation. Subsequently, the OpenOffice
developers who had formed the new foundation
were asked to resign from the OpenOffice project,
for "conflicts of interest." On November 1, 2010, 33
OpenOffice developers tendered their resignations
from the OpenOffice project, and began developing
LibreOffice, based on the OpenOffice 3.3 beta code.

Meanwhile, the Go­OO project was merged into the
LibreOffice project, and improvements made in other
forks of OpenOffice are expected to be merged into
LibreOffice in the future. You may recall that Go­OO
was the version of OpenOffice that was in the
PCLinuxOS repository.

The birth of a new office suite
LibreOffice 3.3.0 Beta 1 was released on September
28, 2010. Two additional betas were released in
October and November, 2010, one each month. The

first release candidate came out in early December,
2010, followed by an additional release candidate
just before Christmas 2010, and two additional
release candidates coming out in January, 2011.
Finally, on January 25, 2011, the stable version of
LibreOffice 3.3.0 was released.

Many new features have appeared in the latest
stable release, and many of those new features are
exclusive to LibreOffice. The new and exclusive
LibreOffice features include:
• The ability to import SVG files
• Editing of SVG files in LibreOffice Draw
• Lotus Word Pro import filter
• MS Works import filter
• Improved Wordperfect import filter
• New "presenter view" in LibreOffice Impress
• New, easier­to­use dialog for title pages
• Make online help available, via WikiHelp
• "Experimental mode" allows testing of unfinished

features
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This is just an overview of some of the
enhancements that have been made in LibreOffice
3.3.0. To see a full list of the enhancements in
LibreOffice 3.3.0, visit their web site. One of the
things that can't be seen in a list, that's been
included in the reports of nearly all the reviewers,
and that must be experienced, are the speed
enhancements. Without a doubt, LibreOffice 3.3.0
launches much faster than previous versions of
OpenOffice. LibreOffice 3.3.0 also feels much more
responsive, with perceptible speed enhancements
across all the applications in the office suite.
Aside from that, LibreOffice 3.3.0 works and
behaves exactly like OpenOffice. The controls are in
the same location that you've become accustomed
to them being in. The same open document formats
are supported. You can import the same file formats
as usual, including the latest docx, xlsx and pptx
files from that "other" office suite.

Installing LibreOffice 3.3: LibreOffice Manager
PCLinuxOS users have a unique situation. Unlike
users of other Linux distros, who must download and
install LibreOffice through their package manager, or
even worse, who must install LibreOffice from
source, PCLinuxOS users have a dedicated installer
to install LibreOffice 3.3.0 for them, with a minimum
of interaction required. Created by pinoc, the
LibreOffice Manager is included on most default
installations of PCLinuxOS (starting with the 2011
ISO releases). Pinoc must have fed some steroids to
the LibreOffice Manager, because I have found it to
run much faster than the OpenOffice Manager that it
replaces.

The current version of LibreOffice Manager will be
downloaded with your regular updates from
Synaptic. Running LibreOffice Manager requires that
you first exit Synaptic, if it is running, as well as any
running OpenOffice applications. Mysteriously,
LibreOffice Manager identifies Mozilla Firefox as a
running office suite application, and will not run until
you exit Firefox (dialog box below). In that case,
simply exit Firefox, then relaunch the LibreOffice
Manager.

Just a word of caution here: LibreOffice Manager
will remove your copy of OpenOffice, if installed!
OpenOffice's status in the PCLinuxOS repository
has been changed to unsupported, with the release
of LibreOffice. So, if you (for whatever reason) do
not want to remove your installed OpenOffice
applications, then you should not run LibreOffice
Manager. Realize that there will be no further
updates to your OpenOffice applications, since
PCLinuxOS now officially supports LibreOffice over
OpenOffice.

Next, LibreOffice Manager will test your Internet
connection, to insure that your internet connection is
up and running.

You can now select the language and localization for
your installation of LibreOffice. On my machine, the
default selection was for English (USA). If you want
something different, select the radio button next to
the language you want to use, then select the "OK"
button to proceed with the next step of the
installation.

Free At Last! LibreOffice 3.3 Released
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An Xterm window will open, showing the progress,
while loading the package information from the
special repository where the LibreOffice package
files are stored. No interaction is required from the
user at this stage.

In the next step, Java will be installed, if it doesn't
already exist on your computer. Again, no user
interaction is required at this stage.

Next, LibreOffice Manager will download the LO­
base package. Users now have a nice progress bar
displayed across their screen. No user interaction is
required at this stage, either.

After the base package, LibreOffice will download
the LO­help package. Still, no user interaction is
required at this stage.

Once all the packages have been downloaded,
another Xterm window opens and displays the
progress of unpacking and installing the LibreOffice
files. Again, there is no need for any user interaction
at this stage.

Finally, you are given the chance to keep or discard
the LibreOffice RPM packages. If you want to keep a
copy of them in /tmp/LO­rpms, simply select the "No"
button. This might be helpful if you have multiple
computers that you want to install LibreOffice on. In
that case, you can simply copy the RPM packages
and copy them to the other computer (same location
as here, /tmp/LO­rpms). Now, you won't have to
download the packages again. Most users will,
however, most likely select the "Yes" button, which
will delete the LibreOffice RPM files from their
computer.

Summary
The creation of The Document Foundation, and their
subsequent development of LibreOffice, insures that
there will always be a capable, high quality, free
office suite available to computer users. It liberates
that free office suite from the whimsy of a single
corporate entity, who may choose to cancel the
project at any time, for any reason. It frees the
development model from the often constraining
development environment of a large single corporate
entity with large overhead that may not be able to
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adapt to a rapidly changing software environment. It
makes that free office suite an open collaboration of
many contributors, exemplifying the free and open
ideology that is embraced by supporters of FOSS,
and one that is responsible to the users, rather than
the interests of a single corporate entity.
Built upon the strong legacy of OpenOffice's 10 year
history, the new LibreOffice 3.3.0 Office Suite is a
definite step forward, both in the terms of features
and in speed. The LibreOffice Manager represents a
large step forward for PCLinuxOS, making the
installation of LibreOffice faster than the OpenOffice

Manager that it replaced, with a minimum of user
interaction required throughout the installation
process. Pinoc has done an exceptionally good job

making a capable, fast installer for LibreOffice,
limited only by the speed of your computer and the
speed of your internet connection.

Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get

Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Screenshot ShowcaseScreenshot Showcase

Posted by bones113, February 11, 2011, running KDE 4.
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by Darrel Johnston (djohnston)
Most who used Amiga computers in the 1970s and
1980s came to love the capabilities of the machines.
A well equipped Amiga would “run circles” around
any other personal computer of the time. But, the
history of the Amiga and Commodore Business
Machines is a long and contentious one. And PC
hardware and software has come a long way since
then. Since Commodore declared bankruptcy in
1994, ownership has changed hands many times.
AmigaOS is the default native operating system of
the Amiga personal computer. It was developed first
by Commodore International, and initially introduced
in 1985 with the Amiga 1000. Early versions (1.0­
3.9) run on the Motorola 68k series of 16­bit and 32­
bit microprocessors, while the newer AmigaOS 4
runs only on PowerPC microprocessors.
On top of a preemptive multitasking kernel called
Exec, it includes an abstraction of the Amiga's
unique hardware, a disk operating system called
AmigaDOS, a windowing system API called Intuition
and a graphical user interface called Workbench. A
command line interface called AmigaShell is also
available and integrated into the system. The GUI
and the CLI complement each other and share the
same privileges.
AmigaOS can be divided into two parts: the Kickstart
(ROM) and Workbench disks. Versions of Kickstart
and Workbench used to be released together, for
use with each other. Since Workbench 3.5, the first
release after Commodore International stopped
development, however, new Kickstart revisions
stopped being produced, relying instead on a 3.1
ROM that is patched during boot.

The AROS project, started in 1995, has over the
years become an almost "feature complete"
implementation of AmigaOS. This was achieved by
the efforts of a small team of developers. AROS
used to mean Amiga Research Operating System,
but to avoid any trademark issues with the Amiga
name, it was changed to the recursive acronym
AROS Research Operating System.
It can currently be installed on most IBM PC
compatibles, and features native graphics drivers for
video cards such as the GeForce range made by
Nvidia. As of May 2007 USB keyboards and mice
are also supported. While the OS is still lacking in
applications, a few have been ported, including E­
UAE, an emulation program that allows 68k­native
AmigaOS applications to run. Some AROS­specific
applications have also been written. AROS has
TCP/IP networking support. The Poseidon USB
stack has been ported to AROS.
AROS is designed to be source­compatible with
AmigaOS, but not binary­compatible. Source code
that will compile on AmigaOS should compile on
AROS, but binaries already compiled for AmigaOS
will not run, even if they are compiled for the same
family of CPU. This means that, unlike MorphOS or
AmigaOS 4, AROS is not capable of running legacy
software directly, only applications compiled for
AROS. There are plans to integrate the Amiga
emulator E­UAE directly into AROS to run AmigaOS
applications, and even a bounty to run MorphOS
software on the PowerPC build of AROS.
The aim of AROS is to remain aloof of the legal and
political spats that have plagued other AmigaOS
implementations, by being independent both of
hardware and of any central control. The de­facto

motto of AROS, "No schedule and rocking" both
lampoons the infamous words "On Schedule and
Rockin'" from Amiga, Inc. CEO Bill McEwen, and
declares a lack of the formal deadlines.
Paolo Besser develops the Icaros desktop as an
enhanced version of AROS. He recently released
version 1.2.6, which can be downloaded at:
http://www.icarosdesktop.com/icarosfiles/IcarosLive_
1_2_6.7z.exe. The file is actually a self­extracting
7zip. So, after downloading, Linux and Mac users
should delete the .exe portion of the file name before
extracting. Extracting the 7zip file results in a folder
containing an iso image, some document files, and
another folder with Windows executables and
configuration files for the Bochs emulator. To run
Icaros in VirtualBox, we only need the iso, which is
named icaros­pc­i386.iso, and is 1.8GB in size.
I began the installation as Operating System Type:
Other, and Version as Other/Unknown.

Alternate OS: Icaros, Part 1Alternate OS: Icaros, Part 1
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On a real Amiga system, the partitions are named
System and Work. Note that the partitions can
actually be created as one drive, with the logical
Work partition being defined as an Amiga
assignment. For this project, I created two separate
VM hard disks.

The System drive is the IDE primary master, and the
Work drive is the IDE primary slave. The CD/DVD
drive is the IDE secondary master.

I also assigned the VM 512MB of RAM, and 64MB
of video memory.

Booting from the CD/DVD, we first see the GRUB
screen (top right.) Note that the default option is the
second line, “Icaros Desktop (16M colour VESA
graphics)”. Using that option will result in a VM
screen size of 1600x1200. Since my real screen
size is only 1280x1024, it’s not very convenient
having to use sliders to move around inside the
virtual machine. I chose the 1024x768 option
instead.
First boot from the DVD (right.) Note that there is an
“InstallAROS” icon on the desktop. It looks as
though we can simply just launch that application to
begin the installation. However, looks can be
deceiving. If we begin the installation now, we will

Alternate OS: Icaros, Part 1
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get nowhere fast. The installer offers an option to
wipe the drive, specify the drive type, and specify
the partitions and partition sizes. However, I’ve
found no way to make the wipe drive option work
correctly. I believe the option is actually a
“placeholder” for future implementation of the
feature.
We are going to manually create the drive partitons,
using the provided AROS tools. This is where it gets
a little tricky. The reason is that the original Amigas
use a rigid disk block (RDB) to store store the disk's
partition and filesystem information. The PC
equivalent of the Amiga's RDB is the master boot
record (MBR). Unlike its PC equivalent, the RDB
doesn't directly contain metadata for each partition.
Instead it points to a linked list of partition blocks,
which by itself contains the actual partition data,
their start, length, filesystem, their boot priority and
their buffer memory type. Because there is no
limitation in partition block count, there is no need to
distinguish primary and extended types and all
partitions are equal in stature and architecture. The
data in the Rigid Disk Block must start with the ASCII
bytes "RDSK". Furthermore, its position is not
restricted to the very first block of a volume, instead
it could be located anywhere within its first 16
blocks. Thus it could safely coexist with a Master
Boot Record, which is forced to be found at block 0.
The AROS partitioning scheme will combine the
RDB and MBR partitioning methods. We will begin
by double clicking the AROS Live CD icon to open
its contents (at right top.)
We then double click the Tools directory, which looks
like a file cabinet. In Amiga terms, directories are
drawers, instead of folders. We can accomplish the

same task by using the Icaros menu, and selecting
System Disk > Tools > HDToolBox, which is the
partitioning tool.

The root level of the HDToolBox shows us the
possible devices. We are only concerned with the
ata.device, which contains 2 units. Double click the
ata.device.

Unit 0 corresponds to the System hard drive and
Unit 1 corresponds to the Work hard drive.

Alternate OS: Icaros, Part 1



37

We must first create a partition table for the drive.
The partition type is PC­MBR. Click the Create Table
button. Select PC­MBR in the Partition Table
window, then click OK.

Before proceeding further, we need to save our
changes. Click the Save Changes button.

Verify we wish to save the changes by pressing
either the Yes or All button.

Next, we double click on Unit 0. Click the Add Entry
button to begin creating a partition table. The default
window shows Unselected Empty. Click Selected
Empty to create a partition table of the entire disk,
then click the Ok button.

We now have a Partition Type of AROS RDB
Partition Table, but the Partition Table is Unknown.
Click the Create Table button. Select RDB in the
Partition Table window, then click the OK button.

Next, we have to make the partition active in order to
be able to boot from it. Click the Switches button.
Click the Active button in the Switches window,
which results in a check mark, then click the OK
button.

Alternate OS: Icaros, Part 1
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Note that we still have no defined partitions, just a
partition table. Double click Partition 0.

Click on Selected Empty to create a partition size of
the entire disk. Then click the Ok button.

DH0 is automatically inserted as the first partition
designation.

Click the Switches button. Click the Automount and
Bootable buttons, resulting in check marks. Click the
Ok button.

The default filesystem type is Fast Filesystem Intl
(International). From past experience, the FFS has
proven to be very unstable and worrisome. A sudden
reboot or powerdown can result in the loss of the
entire partition’s contents. Click the Change Type
button. In the Partition Type window, select Smart

Filesystem. The first SFS option listed is BE (byte
encoded) and the second SFS option is LE (length
encoded). Choose SFS BE, then click the OK
button.

At this point, we have made a lot of changes which
have not been saved yet. But the Save Changes
button is ghosted out, and is not selectable. Click the
Parent button until we come back to the window
showing Unit 0 and Unit 1.

Alternate OS: Icaros, Part 1
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Note the *S to the left of Unit 0. It’s an indication that
there are unsaved changes. Click the Save Changes
button.

We must now repeat the same steps in order to
create a partition for Unit 1.

We only need one bootable disk, so we will leave the
Active button unchecked in the Switches window.

Click the OK or Cancel button. Then, double click
Partition 0.

Again, DH0 is inserted as the default partition
designation. But, we already have a DH0, and we
don’t want two. Click the Rename button, change
the name to DH1, then click OK.

Once again, we have made changes that are not yet
saved. Click the Parent button until you are at the
window showing Unit 0 and Unit 1. Be sure Unit 1 is
highlighted, then click the Save Changes button.
After all this work, it is a temptation to now run the
AROS installer. However, the system won’t
recognize the hard drive partitions until the OS has
been rebooted. Click the Icaros menu button and
select Exit. In the User Request window, click the
Reboot button
Once we have rebooted, we can begin the AROS
installation by double clicking the InstallAROS icon
on the desktop. Please take heed of the warnings in
the AROS Installer window. We’re running in a VM,
so we’re not particularly worried about data loss. But
data loss is a distinct possibility when running on
real hardware.

We’ve already created the AROS partitions needed,
so the default selection is to use the existing
partitions. Click the Proceed button.

Alternate OS: Icaros, Part 1
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I’m only going to use one language, so I leave that
option unchecked. Non­English users, or those
wishing to use more than one language will want to
check that option. I’m not a developer, so I leave that
option unchecked. Developers, developers,
developers! (Shades of Steve Ballmer. See here:
http://www.youtube.com/watch?v=8To­
6VIJZRE&feature=player_detailpage. WARNING:
Video is scary!) Click the Proceed button.

The partitions are unformatted, so we want to select
those options. We also want to use the Work
partition, and put all the Extras files there, so select
those options.

GRUB will be installed to the MBR on ata.device. Its
configuration files will be placed in /boot/grub. I
changed the Menu Mode from Text to Graphics.
Click the Proceed button.

If you’re sure you wish to continue, click the Proceed
button. Otherwise, click the Back button to review
the options.

The installer is running.

The installation is almost complete. Click the
Proceed button to finish the installation (top of next
page.)

Alternate OS: Icaros, Part 1
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At this point, selecting to reboot from the Icaros
menu will simply restart Icaros, but will not restart
the VirtualBox virtual machine. (You may have to
see this in action to fully understand.) We now wish
to detach the DVD from the VM and boot from the
System hard drive. For that reason, we will power off
the VirtualBox VM.

We have now detached the icaros­pc­i386.iso DVD
from the virtual machine. The default GRUB boot

option is still not the one I want. I will edit the
/boot/grub/grub.cfg file later to change the default
boot option.

On first run, you are offered the option to configure
the installation options. I chose to configure them.

This is self­explanatory.

I chose to keep this option enabled.

I may want to share files between the VM and the
host, so I chose to enable this option.

AmiStart is the menu bar we have already seen at
the bottom of the Icaros desktop. I chose to keep it
(next page.)

Alternate OS: Icaros, Part 1
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I chose the compact menu mode which is also used
on the live DVD.

I don’t wish to control the Icaros desktop remotely.
Life is complicated enough, as it is.

More options windows eventually appear, stacked
upon one another. Music unit is the default option for
sound playback.

The only other option shown to me for a sound
source is Unit 0. That shows the ac97 option, which
is what the VM uses. Clicking the Play a test sound
button produced an audible two second tone.

Wanderer is the menu toolbar which is accessed by
right­clicking the “Workbench Screen” bar at the top
of the desktop. I left the General tab with the default
options.

Clicking the Toolbar tab in the Wanderer Prefs
window shows an option to enable the toolbar. I
selected that, resulting in a checkmark.

Alternate OS: Icaros, Part 1
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I left the IControl Preferences at the defaults.

I left the ScreenMode Preferences at default.

After saving the ScreenMode Preferences, Intuition
(window manager) will attempt to reset the screen.
Because we have two more preferences windows
still open, select Cancel here (top center.)

I chose the default American PC 104 keyboard.
(There are lots of keyboard options, as well as a
Mouse options tab.)

I left the default character set at its default option.
Double clicking English in the Available Languages
column moves it into the Preferred Languages

column. You can select more than one preferred
language.

I changed the default U.S. Eastern time zone to U.S.
Central by clicking the appropriate spot on the world
map.

Alternate OS: Icaros, Part 1
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Here I am going to restart the Icaros desktop,
without leaving the virtual machine. I start by clicking
the Icaros menu button.

I select Exit from the menu. Just to be on the safe
side, I saved the preferences.

Next, I clicked the Icaros menu button again,
selected Exit, and clicked the Reboot button. Again,
this will restart the Icaros desktop, but not the
VirtualBox session. (NOTE: There is no Shutdown
option. Clicking the Quit button will simply end
the Icaros toolbar session at the bottom of the
desktop.)

After restarting the Icaros desktop, I selected
the Wanderer (file manager) menu by right­
clicking on the “Workbench Screen” toolbar at
the top of the screen. I then selected Wanderer
> AROS > About...

The installed version is 1.2.6, released January
26th, 2011.

Next month, we will take a look at some of the
capabilities of Icaros. Note that all of the preferences
which were set on the first run can also be changed
later, from the Prefs section of the menu, or by
opening the Prefs drawer (directory) of the System
hard drive. Also note that the System hard drive is
labelled as AROS on the desktop. I’m not sure, but I
think that’s a newer feature.

Alternate OS: Icaros, Part 1
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ms_meme's Nook: PCLOS May Call Youms_meme's Nook: PCLOS May Call You
PCLOS may call you no matter where you roam
In your heart you'll hear it call you

Come on home
Come on home

PCLOS will whisper no matter where you may be
Here am I your special OS

Come to me
Come to me

Your own special desktop the choice of your dreams
Try all those widgets and choose your own themes

If you try PCLOS you'll become a devotee
It will be your special OS and that's a guarantee

PCLOS
PCLOS

PCLOS

http://www.pclosmag.com/html/Issues/201103/files/pclosmaycallyou.mp3
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by Daniel Meiß­Wilhelm (Leiche)
Translated from German by Longtom

When it comes to editing video, converting video
files, or preparing video to burn to a DVD, it's hard to
beat the capabilities of Avidemux.
Avidemux is in the PCLinuxOS respository, and it
comes in three flavors: a command line version, a
Gtk+ version and a Qt4 version. Functionally, the
latter two GUI versions are identical.
Once you open AviDemux for the first time, you will
see the following window:

Use “Open” to start the file browser and find video or
picture files. Video formats would be mpg, vob and,
as the name indicates, avi. Picture formats (like jpg,
bmp, png) will also be listed, and possibly others.

I have chosen a screen cast from Derek Wyatt.

A click on “File > Information” reveals some details
concerning the loaded video. When you make a
DVD, keep in mind that there are certain standards
that apply. One of those would be resolution. Under
PAL, we use the following:
720×576 very good quality depending on

compression 2h video
704×576 very good quality depending on

compression 2h video
352×576 good quality up to 4h video
352×288 satisfactory quality up to 6h video
Under NTSC, we use the following resolutions:
720x480 very good quality depending on

compression 2h video
704x480 very good quality depending on

compression 2h video
352x480 good quality up to 4h video
352x240 satisfactory quality up to 6h video
It all depends on the rate of compression.

You can jump back and forth with the slider, or
define a part of the video you intend to work with.
We mark the beginning of such a part with “A” and
the end with “B”.

Avidemux Under PCLinuxOSAvidemux Under PCLinuxOS
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The selection is displayed again in the bottom right
hand corner (marked in red). Since the selection is
done, we can focus now on the different filters
available. We choose “Video > Filter” and get the
following window:

The “Crop” filter is for cutting off unsightly edges.
Click on “Crop” and the following window appears:

The edges to be cut off are marked green. We click
“OK” and we are returned to the “Video Filter
Manager.”

In the right pane of the window, we see that our first
filter has been activated. To make sure the filter
works as desired, switch from “input” to “output.” All
filters will be applied in real time. Depending on the
intensity of the filter, this can place a heavy load on
your CPU.

That means the video can not be played back
fluently. The video is not standards compliant any
more. This could be rectified by “Add Black Borders.”
Add the appropriate number of vertical lines, as well
as horizontal, in order to arrive at a standard size. I
suggest adding similar amounts for top and bottom,
as well as left and right, in order to keep the visible
part of the video in the middle.

Original Picture

Add border bottom only

Add border top and bottom

Avidemux Under PCLinuxOS
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If you scroll down in “Transform” in the Video Filter
Manager, you'll find the filter “Fade.” This filter can
be used to blend your video in and out whenever
desired. Please make sure that you use the frames
which have been previously marked only.

Don't forget to tick “blend to black.” The fading time
can be chosen freely and according to taste. We are
now entering an area where opinions differ. Some
would do it one way, others a different way. Just be
sure the result is what is you desire.

In this picture, (bottom of previous column) we see
some comb filtering forming. How that happens and
why is something I will explain later, together with all
the other filter options. In the Video Filter Manager, I
chose “Interlacing” in the left field, and chose
“Separate Fields” on the right. Unfortunately, this
filter has a side effect. The resolution changes from
704x576 to 704x288 and the frequency from
25.000fps to 50.000fps (29.97 to 59.94 in NTSC).
Especially the 50.000fps (25.000fps = 25 frames per
second in PAL, and 29.97fps in NTSC) are not
standard.
In the Video Filter Manager, we need to go back to
“Transform” on the left and choose “Resample fps”
in the right frame. Now we can adjust the frequency.

The resolution is still not right, and the display is out
of focus. We will leave the video interlaced, so we
will have to choose this accordingly with the encoder
codec later.

To save time authoring the DVD later, we correct the
proportions of the picture sides. In the Video Filter
Manager, choose "Mplayer resize" function under
“Transform.”

Now choose the size 720x576 (720x480 with NTSC
video). We need a ratio of 4:3, and not 16:9. Let's
have a look at the encoder options.

Avidemux Under PCLinuxOS
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Underneath “Video” choose the DVD (lavc) codec.
Afterwards, choose “Configure,” and choose a
setting possibly like this one in the screen shot at the
top of the next column.
With a standard DVD, the GOP size in PAL is 15.
The GOP size for NTSC video is 18. As mentioned
before, change Interlacing from “Progressive” to
“Interlaced TTF.” The aspect ratio should be 4:3. We
will leave the other settings as they are.

Audio Options:
In Audio, the standard for DVD is 48.000 kHz and
MP2. AC3 and Wave can also be used. Wave should
only be used if you want to fill up the DVD, since it
uses a lot of space. Let us choose configure:

With MP2 (Twolame), a bitrate of 128 is standard.
This is also standard for MP3. However, I prefer to
use a bitrate of 192 kbps.
In Filters:

These settings are self­explanatory. I learned that if
the audio remained at 44.100kHz, that it would not
be DVD standard compliant any longer. The DVD
standard requires a 48,000 Hz sampling depth. As a
result, I would then have to change the setting to
48,000. Because of this, we check the “Resampling”
check box.

Avidemux Under PCLinuxOS
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In “Format” we choose the setting MPEG­PS (A+V).
Once all the settings are completed we click “Save”
and we are returned to the file browser.
Now name your video and sit back. Depending on
which filters you have chosen, this can take a while.
Remember that working with video files can be a
lengthy process.
Now, let the creativity flow.

It's easier than E=mc2
It's elemental

It's light years ahead
It's a wise choice

It's Radically Simple
It's ...

Screenshot ShowcaseScreenshot Showcase

Posted by Ramchu, February 4, 2011, running KDE 4.

Avidemux Under PCLinuxOS

http://www.pclinuxos.com


51

by Patrick G Horneker (phorneker)

This article complements "WindowMaker On
PCLinuxOS: Introduction." Here I give you the
basics on how to use WindowMaker as a
PCLinuxOS desktop. Shown here is a default
WindowMaker desktop with xterm open.

This desktop looks quite plain when compared with
KDE, GNOME, Enlightenment, XFCE, or LXDE.
However, the WindowMaker desktop is very
configurable, simply by launching WindowMaker
Configuration Manager from the system menu. The
utility can be found under More Applications >
Configuration.

The WindowMaker Dock
The 64x64 pixel icon with the GNUStep logo at the
upper right hand corner of your screen is the Dock.

What you see here is what you see when you first
launch WindowMaker. In PCLinuxOS (and in
Mandriva), there are two icons below the GNUStep
icon. The dock has been configured to show the
system date and time, and a launcher for a terminal
window (xterm).
This dock is expandable by dragging icons on the
lower left hand corner of the screen to the bottom of
the stack.
There are two kinds of icons that can be dragged to
the dock. The first kind is a created by a currently
running application such as Firefox, OpenOffice.org,
or the GIMP. The icon associated with the
application appears at the lower left hand corner of
the screen. The icon at the bottom of the dock is a
launcher for a terminal emulator (xterm). In the
screenshot below, I show you a way to move these

icons to the dock. Since there is limited space on the
dock, I recommend using this for applications you
use often.
The other kind of icons is a collection of applets
developed for WindowMaker and AfterStep (another
window manager that provides a NeXT­like
interface, and also installable from Synaptic). These
applets run inside a 64 x 64 icon. The calendar
(below the GNUstep icon) is an example of a
WindowMaker applet. (Visit the WindowMaker
website for examples.)

Workspaces in WindowMaker
Like GNOME, KDE, and other
desktops available for PCLinuxOS,
WindowMaker comes with four
workspaces already configured.
The icon on the upper left hand

corner is what you use to switch between

WindowMaker on PCLinuxOS: The BasicsWindowMaker on PCLinuxOS: The Basics
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workspaces. The Clip is another example of a
WindowMaker applet. Simply click on the arrows (at
the upper right and lower left corners) to change
workspaces.
Here is a bonus. The Clip is another Dock! Unlike
the workspace controls in KDE, GNOME, XFCE, and
other PCLinuxOS desktops, you can actually dock
icons here, at any edge of this icon, not just the
bottom. In fact, icons on this dock can expand the
same way that metal objects can stick to a magnet.
(Remember those science experiments in
elementary school involving magnets?)
Also, icons docked to the Clip apply only to the
current workspace where the icons are docked.
Icons applied to the Dock apply to all workspaces.

The System Menu
Right click anywhere in the
background to pull up the
System Menu. As configured in
PCLinuxOS (and Mandriva), this
menu is the same as the menus
for all other desktops available
in PCLinuxOS. This provides
consistency between desktop
environments if you have
multiple desktops installed (e.g.
WindowMaker installed along
with GNOME, KDE, E17, XFCE,
etc.).

With this configuration, the menu changes as you
install and remove applications from within Synaptic.
Note: With some other distributions such as
Slackware, openSuSE, Ubuntu and Fedora, there is
a default menu setup by the developers of
WindowMaker. You can configure WindowMaker to
use this menu, but the menuing system here is not
compatible with the menuing system configured
with PCLinuxOS and Mandriva.
This means that if you choose to use the
WindowMaker default menu configuration instead of
the PCLinuxOS default menu configuration, the
menu you see will not change when you use
Synaptic to add software, remove software, or
update PCLinuxOS. If you use the WindowMaker
default configuration, you will have to manually edit
the menus using the Preferences utility or the
WindowMaker Configuration Manager.
To maintain the consistency we expect from
PCLinuxOS, I do not recommend reconfiguring the
menu in WindowMaker.
You can also pull up the menu by pressing the F12
key on your keyboard.

Launching Applications
In addition to the System Menu, you can launch
applications by double clicking on application icons
that are docked in either the Dock or the Clip.
Double clicking on the icon that looks like a 3D view
of a monitor displaying the GNUstep logo opens a

terminal window where you can launch applications
from the command line.

Switching Windows
Press F11 on your keyboard to pull up a list of
windows that are currently open on your desktop.
You can select an open window from the menu that
pops up. You can also use Alt­Tab to switch
between windows the same as in Windows or in
KDE. (Using Alt­Tab displays windows as icons,
and is much cooler than using the F11 method.)

Exiting WindowMaker
Of course, you will want to exit WindowMaker when
you are finished with your session. This is
accomplished by selecting Exit > Exit from the
System Menu. Selecting Exit > Restart will restart
WindowMaker with the current configuration. This is
useful when you actually make changes to the
WindowMaker configuration that require a restart to
take effect.

Your Home Directory
When you launch WindowMaker for the first time, a
directory structure is created in your home directory.
This is where you can install wallpapers, themes,
icon sets, pixmaps for tiling. The directory structure
is used by WindowMaker to store preferences on a
per user basis.

WindowMaker on PCLinuxOS: The Basics
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This directory structure starts with ~/GNUStep, and
is the root directory for everything WindowMaker and
AfterStep related.
~/GNUstep/Defaults is where WindowMaker

stores all preferences and user customizations.
~/GNUStep/Library/WindowMaker is where

you install wallpapers, tiles, icons, etc. and is
available only when you login to the desktop (i.e. on
a per user basis).
~/GNUstep/Library/Icons is for icons that

are shared between WindowMaker and AfterStep.

The GNUstep/Defaults directory
WMGLOBAL is where session defaults are stored

and used throughout WindowMaker.
WMRootMenu is the location where contents of

the System Menu are found. (Should be/usr/share/WindowMaker/menu in PCLinuxOS.)
WMState keeps track of where icons are on the

desktop and the configuration of each icon, including
the Dock and the Clip.
WMWindowAttributes keeps track of the

location of application icons for each WindowMaker
icon created.
WPrefs stores color customizations.

WindowMaker is where user customizations are
stored.

The GNUStep/Library/WindowMaker directory
Backgrounds is where you install wallpapers for

use with WindowMaker.
CachedPixmaps is where WindowMaker stores

application icons assigned to WindowMaker icons.
IconSets is where you install icon collections for

use with WindowMaker, icon sets are similar to icon
themes for KDE.
Pixmaps is where you install icons and other

graphics to be used by WindowMaker.
SoundSets and Sounds are where you install

audio files for use with WindowMaker. This requires
a separate WindowMaker sound server applet,
which I shall explain later.
Styles is where customizations to the

appearance of the menus are stored. This is similar
in function to styles used by FluxBox and BlackBox.
Themes are where you store WindowMaker

themes. Themes are stored as .tar.gz files.
WPrefs are other customizations to

WindowMaker are stored on a per user basis.

1. All the contents of the NEW PCLinuxOS Magazine are only
for general information and/or use. Such contents do not
constitute advice and should not be relied upon in making (or
refraining from making) any decision. Any specific advice or
replies to queries in any part of the magazine is/are the
person opinion of such experts/consultants/persons and are
not subscribed to by the NEW PCLinuxOS Magazine.

2. The information in the NEW PCLinuxOS Magazine is
provided on an "AS IS" basis, and all warranties, expressed
or implied of any kind, regarding any matter pertaining to any
information, advice or replies are disclaimed and excluded.

3. The NEW PCLinuxOS Magazine and its associates shall not
be liable, at any time, for damages (including, but not limited
to, without limitation, damages of any kind) arising in contract,
rot or otherwise, from the use of or inability to use the
magazine, or any of its contents, or from any action taken (or
refrained from being taken) as a result of using the magazine
or any such contents or for any failure of performance, error,
omission, interruption, deletion, defect, delay in operation or
transmission, computer virus, communications line failure,
theft or destruction or unauthorized access to, alteration of, or
use of information contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom the NEW
PCLinuxOS Magazine has no control or connection, business
or otherwise. These sites are external to the NEW
PCLinuxOS Magazine and by visiting these, you are doing so
of your own accord and assume all responsibility and liability
for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The NEW PCLinuxOS Magazine accepts no responsibility for
the content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer
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by Daniel Meiß­Wilhelm (Leiche)
Translated from German by tschommer

At some point, every PCLinuxOS user is going to
want to either update their PCLinuxOS installation,
or they will want to install additional software
packages. In fact, every user who installs
PCLinuxOS should perform an update immediately
after installing PCLinuxOS, to insure that they have
the latest and most stable versions of the software
installed. Whatever the case may be, the user will
need to use Synaptic, the package manager in
PCLinuxOS, to perform these updates and to install
additional software packages.

margarita wrote in the PCLinuxOS forum
comments:
Since I often read that every once in a while a user wants
to enable several repositories, I want to stress once again:
Please activate only one repository!
All servers are mirrors which are not all synchronized at
the same time. In 99% of the time this will lead to
problems.
So please, only use one server that is close to you.
Da ich hier und da immer wieder lese, das einige User
fälschlicherweise mehrere
Paketquellen aktivieren, hier noch einmal der Hinweis.
Bitte aktivieren Sie nur eine offizielle Paketquelle.
Bei allen Servern handelt es sich um Spiegelserver, die
nicht zeitgleich synchronisiert

werden. Dadurch kommt es bei 99% zu Problemen.
Also, benutzen Sie nur einen Server in Ihrer Nähe.

How can I get the most current package list?

Synaptic is either in the panel or can be found in the
menu under Applications > Software Center >
Package Manager. It will appear with one of the two
icons pictured above. You need the ROOT password
in order to run Synaptic.

First, click Reload to update the package list to its
newest versions.

The current package list will be reloaded and
analyzed.
If newer versions of the already installed packages
exist, then you will see the "Mark All Upgrades"
button displayed on the left side.

Mark update for installation
Click on Installed (upgradable) in the left column

Synaptic & The RepositoriesSynaptic & The Repositories
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to see all packages that can be updated. To select
these, simply click on Mark All Upgrades. Another
window will open with the following text:

Click on Mark to continue with the update process,
and then in the main window click on Apply. This will
bring up another window and ask for confirmation
that the updates should actually be installed.

Click the Apply button. Now, there's no turning
back...

… if you don't click on Cancel. This process may
take a while, depending on the size and number of
updates.
After all packages were downloaded, Synaptic will
start installing the updates and deleting the older
versions and obsolete packages.
It may happen that Synaptic informs you that one or
more packages are not available. You have the
option to continue with the installation or to cancel,
after which the packages that have already been
downloaded remain in the cache. It's usually a good
idea to cancel and try again later on, because an
incomplete installation can damage your system.

Changing Repositories
To change the repository simply click on Settings >
Repositories.

In the following window you can select the activated
repository to see detailed information:

Advertisement

Synaptic & The Repositories
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NOTE: A PASS user is one who has recently
donated to PCLinuxOS. The repository URL is sent
to you by Texstar in an email.
To change the repository, remove the checkmark
from the one currently enabled and set the mark for
the one you wish to activate. Afterwards you should
click on Reload in the main window so that the
current package list from the newly selected
repository is downloaded. An appropriate message
should appear when clicking OK in the repository
selection window.
You can also activate two additional sections which
are not actually mirrors, but rather contain additional
packages, such as the Megagames section.
Click on New and enter the following data:
Address:http://ftp.nl.freebsd.org/pub/os/Linux/distr/texstar/megagames/apt/
Distribution: pclinuxos/2010
Section(s): megagames

Searching for Applications in Synaptic
Here you have several options for searching. Click
on

or press Ctrl+F. Now you can enter the program
name or a keyword (e.g. “mpeg”).

If the search was successful you will be presented
with the results:

or the results window will be empty if nothing is
found.
You can also click on any package on the right side
and start typing the name of the application if you
know it.

Finally, since our main repository recently updated
their servers, we have had to update our
sources.list, to insure that Synaptic has all the
current information. From time to time, as mirrors
change and the directory structure of the mirrors
change, you may need to occasionally update the
sources.list. Complete instructions for completing
this simple task are given in the forum, here:
http://www.pclinuxos.com/forum/index.php/topic,873
78.0.html.
Good luck!

Synaptic & The Repositories
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International CommunityPCLinuxOS Sites

NETHERLANDS

TURKEY

DENMARK
CZECHOSLOVAKIA

ITALY

POLAND

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

http://pclinuxos.com/?page_id=215
http://pclinuxos.com/?page_id=213
http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
http://pclinuxos.com/?page_id=188
http://pclinuxos.com/?page_id=186
http://twitter.com/iluvpclinuxos
http://www.pclinuxos.com
http://www.enkiconsulting.net
http://www.mypclinuxos.com/forum/index.php
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Top left: Posted by
Archie, February 22,
2011, running KDE
4.

Top right: Posted by
djohnston, February
3, 2011, running e17.

Bottom left: Posted
by Ramchu,
February 21, 2011,
running KDE 4.

Bottom right: Posted
by tschommer,
February 3, 2011,
running KDE 4.
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